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STEP -1
CREATING A NEW PROJECT

Open the “TRIMBLE BUSSINESS CENTRE” software.

1. Start>program files>Trimble Office> Trimble Business Centre> Trimble Business Centre
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1. Click Start New Project
The following page will display.

3 Trimble Business Center == B

© File Edit Wiew Project Select Point Line Surface Corridor Drafting Image Surwey Field Daka Reports Tools TCC  Window Help
DA Al KALARALA DR IERERD B A

el X B g/ BEERBEEELKEBREREI VR @Y
il T e L IiMia b BB &4

ivR &HEA

T aaufas feo0mf

Start Page |
Template £ | Read Only | Default |
Welcome to Trimble Busin: <Blank Template> Read Only
International Foot Fead Only

L= L T = =
Common tasks US Survey Foot Fiead Only
= Start a new project

@ Open an existing project

B Check for updates

#* Trimble Access Services

Learning aids
© online Help (F1)
T Tutorials

& » workflow Guides

Seths Default |
Delete |
0k I Close

¥ %

-

 EEE0 O

O

#start| | @ Ghss Spider- [L... | (53 co-oRDMATEL... | (53 Trimble | ) s0p TBC.doc - ... |[ ) Trimble Busine...

Click ok.

The following page will display.
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1. Select the Following Command

Menu>File> Save Project
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NOTE: It will save in default path: “C/Documents/Trimble Business Centre”.
User can save it to any specified required path.

THEN CLICK SAVE.



STEP 2

PROJECT SETTING
1. Menu>Project > Project Setting

> SOI PROJECT - Trimble Business Center
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Click Change



€ SOI PROJECT - Trimble Business Center =]
File Edit Wiew Project Select Point Line Surface Corridor Drafting Image Survey Field Data Reports Tools TCC  window Help
(R = R R S S R A I I B = B B EEE &5 | My Filker ~ 7
- o I X S & S B RN s BEIEEBE YA
e T ee e | e % | B B | e

Start Page  Plan Wiew |
& Project Settings
G ororal Informatio [
ol

=]
=

A 2

Select the coordinate system that you want to use from one of [up ta) the last 10
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Click Next
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Click Next and select coordinates system as per requirement.
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Select the coordinate system group from the list on the left, then select the zone from
the list on the right. You can scroll down the lists to see more options.
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Click Next and select Geoid model (the latest geoid model is EGM -2008)
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Click Finish.
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Click OK.

STEP-3
DATA IMPORT

“TBC can import data in its raw ( *dat,*.T01,*.T02) as well as in RINEX format”
1. Menu>File>Import

€ S0I PROJECT - Trimble Business Center

File | Edit Wiew Project Select Point Line Surface Corridor  Drafting Reports Tools TCC  window Help

a7 | My Filker > T 2 o W omm A
e m PRI E M ELAM B BB

Mew Project... Chrl+M

Open Project. .. Chrl+o
Mew Trimble Survey Project {*.kspx)...

Open Trimble Survey Project (*.tspx)...

Close Project

LK

Sawve Project Chrl+S

Save Project As... [ R R . —

Sarve Project As Template. ..

Archive Project. ..

Import

Export
Internet Download T T T T T T T T Tt T T T T/
Import Format Editor
Export Format Editor
Page Setup...

Print Preview

YT LEICEE

Print... Ctrrp T T e R S
1 HATRIMELE BUSINESS CEMTREYSOI PROJECT vee
2 HATRIMELE BUSINESS CEMTREVUK TEST.woe
3 HATRIMBLE BUSIMNESS CEMTREVFIRST PHASE.vce

4 HATRIMEBLE BUSIMESS CENTRE\Copy of GCP_LK UP-TGO, vie

o =
Snap |[Meter |[Local || |[0 |[G][ 147356.922 m. 82617.922 m O
i 5tart| &2 GNSS Spider - [Lo... | ) 2 windows Expl... v| ] SoP TEC.doc - Mi... | € Facebook - Wwindo... | ¥ 501 PROJECT - T... Trimble Business C < (32 W8 W8 Lo i@r 1:40PM




The following page will display.
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Select Your Data and Then Click Import

» ~ The foIIowmg page will dlsplay
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“Here we can edit the point id & instrument height if required and details regarding the field
observation can be checked.”
THEN CLICK OK.
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(After the raw data files are imported, the plan view shows all potential baselines (unprocessed base lines)
in green color in the survey network. Because the data is raw static data, the baselines must still be
processed.)

STEP-4
PROCESSING OF BASELINE

1. Click Add co-ordinate button

Note: “It can be done also by selecting the point and then “right click>Add-coordinate”

»
command
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Select Co-ordinate Type =» Global

Key in your “Latitude, Longitude & Height” and assign it as Control Quality.
Click = Ok

2. Menu>Survey>Processing Baselines

The following page will display.
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Press <Save>to save processing resufts 1 observations selected for saving
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Click Save.
Go to next line
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Press <Save> to save processing results
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If the solution is fixed and there is not any flag symbol on the baseline save the line , otherwise rectify it with
the help of elevation mask and session editor.
NOTE: The blue potential vector showed that the unprocessed base line is processed now.

To open session editor >select baseline>right click the selected baseline>click on session editor
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The following page will display.

Here ,satellite for complete duration of observation or part of it can be disabled
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To chose which satellite or part of it to be disabled> select baseline>right click the selected baseline>
click on baseline processing report

The following page will display.
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1. Summary
2. Session Details

Residuals

1. V.5-V-3(10:21:08 AM-
10:38:46 AM) (S1)
Mean =0.004 m Std. Dev.=0.003 m Min.=-0.005m Max.=0.012m
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31-May-14 10:21:12 AM - 31-May-14 10:38:44 AM
Mean=0.026 m Std.Dev.=0008m Min.=0011m Max =0.044 m
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Here, the time for which residuals are not near the zero line has to be disabled in session editor.
The baseline processing report can be opened in web view or tab view >Reports(in main menu)>Report options>

Baseline processing report
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Inverse Results

Level Report

Materials and Site Improvements Report
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m

Detailed report about baseline processing

Settings

Shaw on reports menu: Yes -

Float (undock) the report window: No

Save intermediate data Yes

m

View in: Web browser -
# Header
+ Footer
& Summary Display -

Re’pon \a'iewvtab

200m

View in:

Select a report viewer to display the report.

[ A oK Cancel | 01 2963.222m, 1547460m
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NOTE: Te blue potential vector showed that the unprocessed base line is processed now.

*Select types of ephemeries through which you want to process ,e.g. broadcast and precise.
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Project Settings

General Information =) Baseline Processing
Coordinate System
Units

Ao start processing:
Store continuous as brajecton: res
Computations Ewent interpolation twpe: Linsar
B ascline Processing

, Ewent interpolation points: z
Processing Start automatic 1D nurmbering A0TO0001
Quality Antenna model Autarmnatic
Satellites
Mebwork djustment
Default Standard Ermars
Feature Code Frocessing
Abbreviations

Ephemeris pe: | Automatic

Ephemeris type:

Change this setting ko spesify which type of ephemeris should be used in baseline processing.
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Precise Ephemeris can be used here if available.
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Elevation mask can be changed here, if required.

Loop Closure

Now before going for the adjustment the loop closure must be checked. The Loop Closure Results report is a
useful way to find large blunders in the data set, Such as errors with antenna heights, one point with different
name or different point with same name.However,loop closure can only be checked in case of close figure
For this select the command

Menu> Survey> GNSS loop closure



The following page will display.
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[Name: C-\Users'hp\Desktop'project'precise processing!luxmi vce
Size: 1 MB
Modified: 01-05-2014 15:40:20 (UTC:3)

Time zone: India Standard Time
[Reference number:

[Description:

Coordinate System
(Name:

Datum:

Zone:

Geoid:

Vertical datum:

Default
WGS 1984
Default

Legs in loop: 3

Number of Loops: 54

Number Passed: 34

Number Failed: 0o
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Pass/Fail Criteria
Best

Summary

GNSS Loop Closure Results
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STEP-5
NETWORK ADJUSTMENT

“Once all baselines in the control network have been processed and reviewed, you can adjust
your survey network”

SURVEY> ADJUST NETWORK

Note:
If the elevation (MSL height) of a station (Bench Mark) is available, then the adjusted
vertical control can be obtained from the network up to sub metre level accuracy.

Click Add co-ordinate button

Note: “It can be done by selecting the point and then “right click>Add-coordinate”
command”

Select Co-ordinate Type = Gird

Key in your “MSL Height” and assign it as Control Quality.
Click = Ok

Select the following command
Menu>Survey>Adjust Network
The following page will display.
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Click = Adjust

NOW Click =» Weighting This step is required if the value shown below the
Postprocessed vector (1.87 in this case) is not coming near about 1
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Make a click on * in Post processed vectors tab:

Now again “Adjust” the data
Note: For Adjustment Report
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Point to be checked in Network Adjustment Report

Network Reference Factor must be one or near to one

Chi Square Test must be passed

Horizontal and vertical error must be in reasonable limit

All vector must be in black colour under Adjusted GNSS Observations
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Adjustment Settings Network Adjustment Report A

Adj Statisti - -
ustment Statistics Adjustment Settmgs

+ Control Point Constraints Set—Up Errors

* Adjusted Grid Coordinates GNSS
Error in Height of Antenna: 0.000 m
Centering Error: 0.000 m

Adjusted Geodetic Coordinates
Covariance Display

+ Adjusted ECEF Coordinates Horizontal:
Propagated Linear Error [E]: Us.

+ Error Ellipse Components Constant Term [C]: 0.000 m
Scale on Linear Error [S]: 1.960

* Adjusted GPS Observations Three Dimensional
Propagated Linear Error [E]: us.
Constant Term [C]: 0.000 m

* Covariance Terms Scale on Linear Error [S]: 1.960

Adjustment Statistics

Number of Iterations for Successful Adjustment: 2
Network Reference Factor: 1.00
Chi Square Test (95%): Passed

Precision Confidence Level: 95% v

27 C\Users\hp\AppDataiLocalh Temp\TECTemporali301 O + & & Network Adjustment Report %
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* Adjustment Settings ~
Adjusted Geodetic Coordinates
* Adjustment Statistics
Point ID Latitude Longitude (]13; lf:t) Hel(g\?l tEr)r or Constraint
« Control Point Constraints — eter. Jefer, —
’ . . BADSAIBAG N30°19'27.03318 E77°38'50.39976 379.085 0.051
* Adjusted Grid Coordinates BIIARIGARH N30°06'24 31225" E77°50'04.38991" 272743 0.054
CHHUTMALPUR N30°01'15.80241" E77°43'54.93407" 243 841 0.050
+ Adjusted Geodetic Coordinates | [DARA RIT N30°20'37.75903" E77°42'38.12520" 624.762 0.045
DAT KALI N30°10'40.31027" E77°54'20.48698" 423.740 0.057
+ Adiusted ECEF Coordinates EAST END N30°17'06.92861 E77°58'26.04106 555861 7 LLh
SClReiiit St FATEHPUR N30°02'41 62938" E77°45'44.42007" 249778 0.083
+ Error Ellipse Components [GANDEWAR VILLAGE N30°12'06.51835" E77°35'50.75162" 258.795 ? LLh
[GANESHPUR N30°08'36.85398" E77°52'10.91034" 332216 0.040
« Adjusted GPS Observations [IHAIRA N30°20'50.33267" E77°52'17.08659" 472385 0.059
[KALSIA CANAL N30°08'35.90592" E77°36'57.67944" 250337 0.085
o LODHIWALA N30°04'57.07964" E77°47'56.96987" 252244 0.039
« Covariance Terms
- PADMA RIVER N30°16'31 35878" E77°3738.30688" 204254 0.036
SAHASPUR N30°23'36.64796" E77°48'19.98528" 132386 0.054
Speed up brawsing by disabling add-ans. Choose add-ons Askmelater | ¥ x v

O ZS <« %0 03:43
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* Adjustment Settings ~
* Adjustment Statistics
+ Control Point Constraints Ad‘IHSted ECEF Coordinates
* Adjusted Grid Coordinates Point ID X X Error Y Y Error z ZErrer || 3D Error Constraint
(Meter) (Meter) (Meter) (Meter) (Meter) (Meter) (Meter)
) ) ) BADSAIBAG 1178858 381 0012 5382955 286 0.043 3201636122 0.026 0.052
* Adjusted Geodetic Coordinates — — —
BIHARIGARH 1163799.716 0.012 5398346 663 0.046 3180753548 0.027 0.055
CHHUTMALPUR 1174473538 0.013 5401079.597 0.042 3172516.942 0.027 0.051
* Adjusted ECEF Coordinates [DARA RIT 1172725 636 0.010 5383385.880 0.038 3203640.107 0.024 0.046
« Error Ellinse Combonents DATKALI 1156293 960 0,012 5396244 379 0.048 3187646769 0.030 0.058
EAST END 1148643760 2 5391865 580 ? 3198000239 ? 2 LLh
Adiusted GBS OB ) FATEHPUR 1171327.166 0.023 5400414 549 0.070 3174807.996 0.042 0.084
. e rat] = = — o - -
S T [GANDEWAR VILLAGE 1184992 332 B 5388302191 ? 3189858.510 2 ? LLh
|GANESHPUR 1160068441 0.009 5397307.051 0.034 3184313 651 0.021 0.041
+ Covariance Terms [HAIRA 1157541.764 0.013 5386336545 0.049 3203897.297 0.032 0.060
[KALSIA CANAL 1183941357 0.024 5392063 162 0.069 3184247287 0.048 0.087
LODHIWALA 1167415363 0.009 5399125 901 0.033 3178419134 0.020 0.039
PADMA RIVER 1181306.335 0.009 5385137.964 0.031 3196922376 0.019 0.037
SAHASPUR 1163178305 0.012 5382437522 0.045 3208296113 0.029 0.055
Speed up brawsing by disabling add-ans. Choase add-ons Askmelater | ¥ v

— M

L A B 09:43

Disclaimer

This SOP is made assuming that user has some previous knowledge of GPS data processing ,However for
user with no previous knowledge of GPS data processing ,hands on training is recommended.



